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1.2 Introdución

Antes de enfrascarse na creación de proxectos, imos ver como xestionalos en Eclipse.• 
Imos ver como importalos e as opcións existentes.• 
É bo botarlle unha ollada ao seguinte material, para evitarse sorpresas desagradables coa perda de proxectos.• 
Como xa se indicou recoméndase a lectura do seguinte documento: "Mi primera hora con Eclipse":
http://ubuntulife.files.wordpress.com/2008/03/intro_eclipse_espanol.pdf

• 

1.2.1 Iniciar Eclipse

Como xa se viu na Unidade 1, imos comezar abrindo o Eclipse como se fose a primeira vez.• 
Escolleremos a perspectiva de Java.• 
O Workspace é o lugar onde Eclipse almacena por defecto os proxectos e información sobre estes nunha carpeta chamada .metadata, que
pode traer algunha que outra complicación.

• 

Iniciar Eclipse• 

Escoller se se desexa que pregunte polo directorio do Workspace a próxima vez que se inicie.

• 
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Pechar a pantalla de benvida.

• 

Escoller a perspectiva Java.

• 

1.3 Crear un proxecto

Un usuario pode ter varios Workspaces ou outros cartafoles para organizar os seus proxectos. Así, pode ter proxectos de distintas materias
ou distintas linguaxes en distintos Workspaces.

• 

Un proxecto pódese crear no cartafol do workspace ou noutra calquera. En calquera caso, almacenarase información sobre os proxectos no
cartafol .metadatos do Workspace co que se estea a traballar.

• 

Agora imos traballar con proxectos lixo para estudar as distintas opcións, logo máis en diante explicarase os campos dos cadros de diálogo.• 
Estes proxectos borrarémolos ao finalizar este apartado.• 

Crear un proxecto lixo• 
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Creamos un novo proxecto de Android.

• 

Indicamos nome da aplicación: Proxecto1.
OLLO! Edición 2015: Indicar como SDK mínimo API 16.

• 

Observar que o proxecto vaise crear dentro do Workspace.

• 
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Premer Next.

• 

Premer Next.

• 
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Indicamos o nome da actividade: Proxecto1.

• 

Proxecto creado no IDE Eclipse.

• 

E na carpeta correspondente ao Workspace.

• 
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Proxecto1 dentro da carpeta do Workspace.

• 

Contido do cartafol Proxecto1. Coincide co contido do Proxecto1 do IDE.

• 

1.4 Cambiar de workspace

Crear máis proxectos lixo• 

Pechamos e abrimos Eclipse, indicamos un novo Workspace para outros proxectos: workspaces2.

• 
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Ao crear un novo Workspace, e iniciar Eclipse por primeira vez, aparece a ventá de Benvida. É como comezar de cero, pero nun novo
workspace.

• 

Igual que antes creamos un Proxecto2.
OLLO! Edición 2015: Indicar como SDK mínimo API 16.

• 

• 
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O proxecto creado no novo Workspace. Ollo non está o Proxecto1.

Premendo en File->Switch Workspace podemos cambiar de Workspace ou ver os dispoñibles, premendo en Other. Neste menú é onde se
pode cambiar de workspace, cando na pantalla de inicio non temos habilitada a opción de escoller.

• 

Tamén se pode pode engadir outro Workspace.

• 

Neste caso imos engadir o workspace3.

• 

• 
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Pechar Eclipse e volvelo abrir. Observar como agora ofrece os 3 workspaces.

Escoller o Workspace3, será como partir de cero ...

• 

Pero como saber en que Workspace estamos?. Hai a posibilidade de indicalo na barra de título.

• 

O ficheiro <ruta instalación de eclipse>/eclipse.ini...

• 

... podemos editalo (A imaxe amosa como facelo en Linux. En Windows editar o ficheiro).

• 
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Engadir ao principio: -showlocation.

• 

Pechar Eclipse e volvelo abrir. Observar a ruta do espazo de traballo na barra de título.

• 

Aquí vemos os cartafois dos tres proxectos.

• 

1.5 Organización de proxectos dentro dun workspace: Working Sets

Xa vimos que se poden ter diferentes workspaces para que o usuario se organice como desexe.• 
Pero dentro de cada Workspace, Eclipse, ofrece a posibilidade de organizar os proxectos en agrupamentos chamados: Working sets.• 
En todo momento podemos mover proxectos dun Working set a outro, ter un proxecto en varios Working sets, decidir que Working sets
amosar/ocultar, etc.

• 
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Crear workingsets• 

No workspace3 crear 2 proxectos Android: (Proxecto3 e Proxecto4) e un de Java (ProxectoJava1)

• 

O contido do Workspace3.

• 

Na Vista de Exploración de Proxectos premer no Menú da Vista (View Menu)

• 
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Seleccionar Working Set...

• 

Crear un Working Set novo.

• 

Podemos crear Working Sets para agrupar, recursos, programas, etc. Neste caso imos escoller Java, pois son proxectos de Java (Android)

• 
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os que imos agrupar.

Poñer un nome ao agrupamento: neste caso Java.

• 

Seleccionar que proxectos o compoñen ...

• 

... neste caso imos pasar o ProxectoJava1.

• 
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Crear outro agrupamento ...

• 

... neste caso co nome Platega Android. Nesta ocasión, a modo de exemplo, non engadimos ningún proxecto.

• 

• 
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Seleccionamos os 2 agrupamentos. Premer en OK.

No Menú da Vista, imos indicar que queremos ver os proxectos organizados por Working Sets.

• 

Podemos configurar que Workings Sets queremos configuar. Marcamos todos, entre eles: Other Projects. Tamén podemos indicar en que
orde desexamos ver os agrupamentos na Vista de Exploración de Proxectos, para iso usaremos os botóns Up e Down.

• 
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No agrupamento Other Projects podemos ver que están os proxectos que non se asignaron ao agrupamentos creados anteriormente.

• 

Premendo en Select Working Set podemos editar e crear novos agrupamentos.

• 
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Editamos o agrupamento de Platega Android.

• 

Asociamos os proxectos de Android a ese agrupamento. Observar como o ProxectoJava1, tamén se podería asignar a este working set, de
modo que ese proxecto estaría en 2 agrupamentos.

• 

• 
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Premer en OK.

Os proxectos organizados nos Working Sets. Indicar que no canto de todo o anterior poderíase ter arrastrado e soltado os proxectos dun
agrupamento a outro na presente pantalla. Volver a editar a configuración ...

• 

Neste caso imos decidir que so queremos que se amosen os proxectos do agrupamento Platega Android.

• 

• 
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E aí o esta !!!

Se queremos ver os proxectos independentemente de como estean agrupados, ... seguir o menú da imaxe.

• 

Ou velos agrupados en agrupamentos.

• 

1.6 Importar proxectos

Os proxectos pódense levar dun equipo a outro simplemente copiando os cartafoles no que están.• 
Neste caso vanse copiar os proxectos contidos no Workspace3 a un novo cartafol chamado probas e logo importaranse.• 

Importar proxectos• 
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Copiar os proxectos contidos en workspace3 a un cartafol chamado probas

• 

Pechar Eclipse e seleccionar o Workspace workspace.

• 

Este xa contiña o Proxecto1. Observar como non están os agrupamentos creado no workspace3.

• 
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Premer en File -> Import

• 

Indicar que é un proxecto de Android.

• 
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Seleccionar o cartafol probas ...

• 

... e automaticamente busca os proxectos que hai na carpeta probas e nas súas subcarpetas (ideal para corrixir proxectos). Observar que
non quere importar o proxecto de Java.

• 
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Indicar que queremos que copie os proxectos do cartafol orixe ao workspace. Co cal se se modifican os proxectos, estes serán os que
estean no workspace e non no cartafol probas.

• 

Proxectos importados ...

• 

E tamén copiados ao Workspace. Observar que proxectos están/ou non en cada cartafol. A partir de agora co cartafol probas pódese
realizar o que se desexe.

• 
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1.7 Proxectos fóra do Workspace

Nesta ocasión imos ver como ter proxectos fóra do Workspace. Aínda así este é necesario para conter o cartafol .metadatos que conten
información, entre outras cousas, sobre os proxectos.

• 

Obviamente, tamén se poden ter outros proxectos dentro do Workspace.• 

Crear proxectos fóra do WorkSpace• 

Abrir de novo Eclipse no espazo de traballo workspace2.

• 

Contén no workspace o Procexto2 creado ao principio.

• 

Crear un novo proxecto de Android ...

• 

https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_67.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_68.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_73.jpg


Nome Proxecto5.
OLLO! Edición 2015: Indicar como SDK mínimo API 16.

• 

Na ruta indicar que se desexa crear noutro cartafol fóra do workspace.

• 
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Ruta para o Proxecto5 fóra do espazo de traballo.

• 

Nome da actividade Proxecto5.

• 

Comparativa entre o IDE e os 2 cartafoles: o do workspace e o que conte? o proxecto5.

• 

Importar proxectos fóra do Workspace• 
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Importar de novo ...

• 

Proxectos de Android ...

• 
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Pero ... esta vez non copiar os proxectos ao espazo de traballo. O resultado será semellante ao anterior. Só que agora os cambios que se
fagan nos proxectos 3 e 4 serán gardados no cartafol probas.

• 

Observar como se distribúen os 4 proxectos do IDE: 1 en workspace2, 1 no cartafol chamado 'proxectos_fora e 2 no cartafol probas

• 

1.8 Borrado de proxectos

Os proxectos pódense borrar dende Eclipse:
Pódese borra só o enlace no IDE, sen borrar os ficheiros do proxecto,♦ 
Ou tamén o cartafol que o contén os ficheiros do proxecto.♦ 

• 

Tamén se poden borrar os cartafoles directamente, pero teríase no IDE un enlace a un proxecto que non existe.• 

Borrar proxectos• 

Borramos o Proxecto2.

• 
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Pero non o borramos en disco.

• 

Unha advertencia ... Seguir...

• 

Vemos que o IDE non ten o Proxecto2, pero este segue no cartafol workspace2.

• 
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Borramos o Proxecto2.

• 

Esta vez si o borramos no disco.

• 

Nin no IDE nin no cartafol probas está o Proxecto3.

• 

1.9 Preferencias: workspaces

Rematamos revisando onde se almacena a configuración relativa aos workspaces anteriores.• 

Preferencias• 

https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_84.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_85.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_87.jpg


Observar os espazos de traballo dispoñibles.

• 

Premer en Window -> Preferences.

• 

En General -> Startup and Shutdown -> Workspaces podemos eliminar a referencias aos espazos de traballo que se viñan usando até
agora. Tamén podemos configurar se queremos que siga preguntado/ou non, ao iniciar Eclipse, polos espazos de traballo.

• 
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Deixamos só espazo de traballo workspace.

• 

Agora xa só hai ese espazo de traballo.

• 

Para limpar todo imos borrar os cartafoles que usamos até agora, salvo ...

• 
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... workspace.

• 

-- Ángel D. Fernández González e Carlos Carrión Álvarez -- (2015).

https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_94.jpg
https://manuais.iessanclemente.net/index.php/Usuario:Angelfg
https://manuais.iessanclemente.net/index.php/Usuario:Carrion

